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TMS320C6748 开发例程使用手册 

 

Revision History 

Draft Date Revision No. Description 

2018/10/29 V3.3 
1. 完善 StarterWare 例程 ECAP_APWM，底板 TL138/6748-E

asyEVM 的 A3 和 A4 版的测试引脚不一样。 
2. UART_INT 例程不适用 TL138/6748-EasyEVM 的 A4 版。 

2018/10/11 V3.2 3. 完善 SYS/BIOS 例程 Board 的操作步骤。 

2018/08/03 V3.1 1.添加算法例程——车牌识别。 

2018/07/24 V3.0 

1.修改 StarterWare 的 DEMO 综合例程——重新换了新的 L
OGO 图片。 
4. 修改 SYS/BIOS 工程新建。 
5. 修改 SYS/BIOS 例程 Queue。 

2018/01/18 V2.8 
1.修改 4.62 NandFlash——NAND FLASH 读写测试，增加了

高配版例程说明。 

2017/03/20 V2.7 

1.添加其他例程 GPIO_LED_C_Mix。 
2.添加其他例程 GPIO_LED_C++_Mix。 
3.添加 SYS/BIOS 例程 AD 模块采集测试（使用 uPP）。 
4.添加 SYS/BIOS 例程伺服电机测试。 

2017/01/20 V2.6 

1. 更新 NSP 组件为 1.10.3.15 版本，程序可兼容旧版本 NS
P，更新以下例程：MJPEG_Streamer、NDK_Runtime、Ra
wSocket、TCP、TCP_Benchmark、TCP_Client、Telnet、U
DP、WebServer、WebServer_Audio_Video、WebServer_R
MII。 

2. 添加 SYS/BIOS 例程 Gate 门保护。 
3. 添加 SYS/BIOS 例程 Queue 队列。 
4. 添加 SYS/BIOS 例程 Event 事件模块。 
5. 添加 SYS/BIOS 例程 Mailbox 邮箱通信。 
6. 添加 SYS/BIOS 例程 CPU 低功耗模式。 
7. 添加 SYS/BIOS 例程 VFSCALE 动态调频调压测试。 
8. 添加 SYS/BIOS 例程综合 demo。 
9. 添加 SYS/BIOS 例程 uPP_B_TO_A 例程 uPP 回环测试。 
10. 添加 SYS/BIOS 例程 NDK_UIA 系统分析基于网络传输。 
11. 添加 StarterWare 例程 SPI_EDMA_FLASH。 
12. 添加 StarterWare 例程 EMIF_AD8568_100K。 
13. 添加 StarterWare 例程 EMIF_AD7606_200K_EDMA。 
14. 添加 StarterWare 例程 EMIF_AD7606_10K。 
15. 添加 StarterWare 例程 TL5147_LCD_2CH_SYNC。 
16. 添加 StarterWare 例程 EDMA3_LED。 
17. 添加 StarterWare 例程 EDMA3_LINK。 
18. 添加 PRU 例程 PRU_AD8568_SAVE。 
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19. 添加 PRU 例程 PRU_TIMER2_POLL。 
20. 添加 PRU 例程 PRUtoDSP_Interrupt。 
21. 优化 VPIF_OV2640 例程，侦率提高至 30 帧，并通过 LC
D 显示帧率。 

2016/12/09 V2.5 

1. 基于算法例程的 ImageProcessQR 二维码扫描测试例程。 
2. 基于算法例程的 ImageProcessChar 文字识别测试例

程。 
3. 基于算法例程的 ImageProcessAlph 字母识别测试例

程。 

2016/08/26 V2.4 

1. 添加基于 StarterWare 的 SD 卡读写测试例程。 
2. 添加基于 StarterWare 的 SPI0 测试例程。 
3. 添加基于 StarterWare 的 UART2 FIFO 中断模式测试例

程。 
4. 添加基于 StarterWare 的 TL5147 摄像头实现 3 路图片采

集 
5. 添加基于 PRU 的 PRU 控制 AD5724 输出连续波形例程。 

2016/07/25 V2.3 
1. 添加 C++的 GPIO 输出例程。 
2. 添加基于 SYS/BIOS 的 UART2 中断接收例程。 

2016/04/25 V2.2 

1. 添加基于 StarterWare 的 5.6、10.4、12、15 寸触摸屏

驱动例程。 
2. 添加基于 StarterWare 的复合视频双通道输入 LCD 显

示例程。 
3. 添加标准汇编的 GPIO 输出例程。 
4. 添加线性汇编的 GPIO 输出例程。 
5. 添加 GPIO_KEY 直接操作寄存器中断实现流水灯例程。 
6. 更新 SD 卡烧写程序到 NAND FLASH 内容。 
7. 更新 Web_IAP 网络烧写工具版本。 

2015/01/05 V2.1 

1. 添加基于 SYS/BIOS 的二进制信号量例程。 
2. 添加基于 SYS/BIOS 的计数型信号量例程。 
3. 添加基于 StarterWare 的 uPP 板间通信例程。 
4. 添加基于 StarterWare 的双 CAN 通信例程。 
5. 添加基于 PRU 的 LED 输出例程。 
6. 添加基于 PRU 的 KEY 输入例程。 
7. 添加基于 PRU 的 DAC 输出例程。 
8. 添加基于 PRU 的 7606 ADC 采集例程。 
9. 添加基于 PRU 的 8568 ADC 采集例程。 
10. 添加基于 PRU 的 uPP 通信例程。 
11. 添加网络烧写程序的操作方法。 
12. 优化 FFT_Benchmark 例程。 

2015/09/24 V2.0 

1. 更新 FaceDetect 人脸识别测试案例。 
2. 删除基于 SYS/BIOS 的 GPIO_LED_CLOCK 例程。 
3. 删除基于 SYS/BIOS 的 AUDIO_LINE_IN 音频输入例程。 
4. 删除基于 SYS/BIOS 的 AUDIO_LINE_OUT 音频输出例

程。 
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5. 更新基于 Starerware 的 Line Out 音频输入（EMDA 方

式）例程。 
6. 添加基于 Starerware 的 Line Out 音频输出（中断方

式）例程。 
7. 添加基于 Starerware 的 Line Out 音频输出（查询方

式）例程。 
8. 添加基于 Starerware 的 Line Out 音频输出（导入文件

方式）例程。 
9. 更新基于 Starerware 的 Line In 音频输入（EMDA 方

式）例程。 
10. 添加基于 Starerware 的 Line In 音频输入（中断方式）

例程。 
11. 添加基于 Starerware 的 Line In 音频输入（查询方式）

例程。 
12. 添加基于 Starerware 的 LineIn 音频输入（保存文件

方式）例程。 
13. 添加基于 Starerware 的 LineIn 音频输入（波形输入

方式）例程。 
14. 更新基于 Starerware 的 Mic In 音频输入（EMDA 方

式）例程。 
15. 添加基于 Starerware 的 Mic In 音频输入（中断方式）

例程。 
16. 添加基于 Starerware 的 Mic In 音频输入（查询方式）

例程。 
17. 添加基于 Starerware 的 Mic In 音频输入（保存文件

方式）例程。 
18. 添加基于 Starerware 的 Mic In 音频输入（波形输入

方式）例程。 
19. 添加基于 Starerware 的 EMIFA 总线 8 通道并口 AD 数

据采集（EMIF_AD8568）。 
20. 添加基于 Starerware 的 EMIFA 总线 8 通道并口 AD 数

据采集（EMIF_AD8568v2）。 
21. 添加 TL6748-EasyEVM 与 TL6748F-EVM 开发板使用 E

MIF 接口模块说明。 
22. 添加基于 Starerware 的 ClockOut时钟输出测试例程。 
23. 添加基于 Starerware 的 CPU 时钟测试例程。 
24. 添加基于 SYS/BIOS 的时间戳（通用）例程。 
25. 添加基于 SYS/BIOS 的时间戳（专用）例程。 
26. 添加基于 SYS/BIOS 的 Line In 音频输入与保存例程。 
27. 添加基于 SYS/BIOS 的 Mic In 音频输入与保存例程。 
28. 添加基于 SYS/BIOS 的 MP3 音频播放（SD 卡）例程。 
29. 添加基于 SYS/BIOS 的 WAV 音频播放（SD 卡）例程。 
30. 添加基于 SYS/BIOS 的网络 Web 服务器（支持串口输

入 IP）例程。 



 

4 

 

2015/05/12 V1.9 

1. 添加基于 Starerware 的 NRF24L01 无线模块测试。 
2. 添加基于 Starerware 的 EMIFA 总线 6 通道并口 AD 数

据采集（EMIF_AD7656）。 
3. 添加基于 Starerware 的 EMIFA 总线 6 通道并口 AD 数

据采集（EMIF_AD7656_v2）。 
4. 添加基于 Starerware 的 HC-SR04 超声波测距测试。 
5. 添加基于 Starerware 的 DHT11 温湿度传感器测试。 
6. 添加基于 Starerware 的串口 WIFI 模块测试。 
7. 添加基于 Starerware 的 RFID 射频识别测试。 
8. 添加基于 Starerware 的红外遥控测试。 
9. 添加基于 Starerware 的 SATA 枚举测试。 
10. 添加基于 Starerware 的串口蓝牙模块测试。 
11. 添加基于 Starerware 的三轴加速陀螺仪测试。 
12. 添加基于 Starerware 的串口转 Zigbee 无线测试。 
13. 添加 H264 编码算法。 

2015/04/30 V1.8 

1. 添加基于 StarterWare 的网络 Web 服务器（使用 RMI
I 接口）例程。 

2. 添加基于 SYS/BIOS 的网络 Web 服务器（使用 RMII 接
口）例程。 

3. 添加基于 SYS/BIOS 的 EDMA3 一维数据传输例程。 
4. 添加基于 SYS/BIOS 的 LineOut 音频输出例程。 
5. 添加基于 SYS/BIOS 的 McBSP_LoopBackMcBSP 内部回

环测试。 
6. 添加基于 SYS/BIOS 的 McBSP 外部回环测试。 
7. 添加基于 Starerware 的 TL5147 复合视频输入 VGA 显

示测试。 
8. 添加基于 Starerware 的 TL5147 复合视频输入 LCD 显

示测试。 

2015/03/18 V1.7 

1. 调整文档目录排版，修改例程分类为 StarterWare、SY
S/BIOS 和算法三部分。 

2. 添加基于 C6748_NandWritev2.out 程序烧写方法，烧

写速度约为基于 C6748_NandWrite .out 的 10 倍。 
3. 添加基于 StarterWare 经过 EDMA 优化的 EMIFA 总线

FPGA 读写测试例程。 
4. 添加基于 StarterWare 的图形库控件例程。 
5. 添加 AAC 解码 AACLCDecode 算法例程。 
6. 添加 AAC 解码 AACHEv2Decode 算法例程。 
7. 添加 AAC 编码 AACLCEncode 算法例程。 
8. 添加直方图均衡化算法例程。 
9. 添加图像反色算法例程。 
10. 添加边缘检测算法例程。 
11. 添加灰度图像二值化算法例程。 
12. 添加灰度图像线性变换算法例程。 
13. 添加图像缩放算法例程。 
14. 添加图像旋转算法例程。 
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15. 添加 G711A 率语音编码算法例程。 
16. 添加 G711A 率语音解码算法例程。 

2015/02/10 V1.6 

1. 添加基于 SD 卡烧写 NANDFLSH 程序方法。 
2. 添加 CCS 开启多线程编译方法。 
3. 添加自动生成 NANDFLASH 烧写.ais 文件方法。 
4. 添加基于 SYS/BIOS 的 IP Camera 例程。 
5. 添加基于 StarterWare 的多串口模块（查询方式）例

程。 
6. 添加基于 StarterWare 的多串口模块（中断方式）例

程。 
7. 添加基于 SYS/BIOS 的定时器（通用）例程。 
8. 添加基于 SYS/BIOS 的定时器（专用）例程。 
9. 添加基于 SYS/BIOS 的定时器（动态创建）例程。 
10. 添加基于 SYS/BIOS 的定时器（动态创建、更改定时

周期）例程。 
11. 更改基于 SYS/BIOS 的 GPIO_KEY_HWI 例程名为 HWI_

Runtime。 
12. 添加基于 SYS/BIOS 的硬件中断（HWI 设备专用组件）

例程。 
13. 添加基于 SYS/BIOS 的硬件中断（HWI 挂钩函数）例

程。 
14. 添加基于 SYS/BIOS 的硬件中断（HWI 发布软件中断）

例程。 
15. 添加基于 SYS/BIOS 的硬件中断（HWI 触发任务）例

程。 
16. 更改基于 SYS/BIOS 的 GPIO_KEY_SWI 例程为 SWI_Ru

ntime。 
17. 添加基于 SYS/BIOS 的软件中断（静态配置）例程。 
18. 添加基于 SYS/BIOS 的软件中断（有条件触发 ANDN）

例程。 
19. 添加基于 SYS/BIOS 的软件中断（有条件触发 DEC）

例程。 
20. 添加基于 SYS/BIOS 的软件中断（无条件触发 OR）例

程。 
21. 添加基于 SYS/BIOS 的 MP3 解码（使能缓存及通过 S

D 存取）例程。 

2015/01/13 V1.5 

1. 添加基于 StarterWare 的关联 32-bit 模式定时器/计数

器例程。 
2. 添加基于 StarterWare 的独立 32-bit 模式定时器/计数

器例程。 
3. 添加基于 StarterWare 的独立 32-bit 模式/额外 4-bit 分
频定时器/计数器例程。 

4. 添加基于 SYS/BIOS 的 UART2 串口查询收发例程。 
5. 添加基于 SYS/BIOS 的以太网数据链路层通信例程。 
6. 添加基于 SYS/BIOS 的 MP3 解码例程。 
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7. 添加基于 SYS/BIOS 的 CodecEngine 数据复制算法例

程。 

2014/12/10 V1.4 

1. 添加支持 4.3 寸屏例程。 
2. 添加基于 StarterWare 的 4 通道 DAC 例程（模拟 SPI
总线）。 

3. 添加基于 StarterWare 的 4 通道 DAC 例程（SPI 总线）。 

2014/11/03 V1.3 

1. 添加基于 TL-EasyBox 实验板 Demo 例程。 
2. 添加基于 StarterWare 的综合例程。 
3. 添加基于 StarterWare 的人脸识别跟踪例程。 
4. 添加基于 StarterWare 的按键触发 EDMA 事件例程。 
5. 添加基于 StarterWare 的按键及定时器中断例程。 
6. 添加基于 StarterWare 的 EDMA 串口收发例程。 
7. 添加基于 SYS/BIOS 的触摸屏例程。 

2014/10/13 V1.2 

1. 增加基于 StarterWare 和 FPGA 通信的 uPP 测试例程。 
2. 增加基于 StarterWare 和 FPGA 通信的 EMIFA 测试例

程。 
3. 增加基于 SYS/BIOS 的 SD 卡 RAW 模式读写测试例程。 
4. 增加基于 SYS/BIOS 的 SD 卡文件系统读写测试例程。 
5. 增加基于 SYS/BIOS 的 WebServer 测试例程。 

2014/10/01 V1.1 

1. 优化 GEL 文件。 
2. 增加基于 StarterWare 的内存读写测试例程。 
3. 增加基于 StarterWare 的 NANDFLASH 读写测试例程。 
4. 增加基于 StarterWare 的 VGA 显示测试例程。 
5. 增加基于 StarterWare 的 RGB24 转灰度测试例程。 
6. 增加基于 StarterWare 的灰度图像直方图测试例程。 
7. 增加基于 StarterWare 的数学函数库测试例程。 
8. 增加基于 StarterWare 的数字识别测试例程。 
9. 增加基于 SYS/BIOS 的工程创建说明。 
10. 增加基于 SYS/BIOS 的例程。 
11. 调整目录结构。 

2014/05/05 V1.0 1. 初始版本。 
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1 TMS320C6748 开发板准备 

测试开发板硬件 

将开发板的 UART2 连接到 PC 机。 

备注： 

 如实验无特别说明，默认都是使用 UART2 作为调试串口。 

 如实验无特别说明，表示广州创龙 OMAPL138/C6748 系列开发板均支持对应实验。 

 广州创龙 OMAPL138/C6748 系列开发板共用此用户手册，由于各个开发板之间的硬

件资源存在差异，因此有部分实验需要在特定的开发板上完成。 

如使用的开发板的 UART2 是 DB9 接口，请将 RS232 串口线通过 USB 转串口转接线连接到

PC 机的 USB 接口。RS232 串口线的另一端 DB9 母头（带孔）接开发板 UART2 接口。 

如使用的开发板的 UART2 是 MicroUSB 接口，请 MicroUSB 数据线插到 PC 机的 USB 接口，

另一头接开发板的 UART2 接口。 

确保 USB 转串口驱动已正常安装后，驱动可以在 tools 目录下找到，也可以使用鲁大

师扫描安装驱动。 

设置 PC 机调试终端 COM 口，波特率为 115200，8N1，无检验位。推荐使用 ZOC 串

口调试终端软件，OMAPL138/TMS320C6748光盘的 tools目录下有 ZOC的安装包 zoc602.zip。

安装方法请查阅使用手册 TMS320C6748 相关软件安装里 ZOC 软件安装步骤。 

假如是使用 ZOC 的用户，依次点击菜 ZOC 单栏的"Options->Jumpto->Devices"，然后

选择"Serial/Modem"。在"Serial/Modem"中扫描然后选择 COM 口，波特率为 115200，8N1，

无检验位，"RTS signal off"，"DTR signal off"，其它选项按默认设置。 

接着点击 Save 完成串口终端的设置。将开发板断电，然后将开发板的拨码开关编号

1～5 对应拨到 00101，1 为 ON，0 为 OFF，这个档位是 UART2 启动模式，Boot 引脚详细

配置说明请查看附录 1。然后将开发板上电，在串口调试终端看到 BOOTME 信息即说明

开发板硬件正常和 USB 转串驱动已正确安装，如下图所示： 
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图 1 

 

 对于开发板常见启动方式，拨码开关 1~5 档位为如下： 

NAND FLASH：01110 

MMC/SD0：00111 

UART1：11101 

UART2：00101 

SPI1 FLASH：00110 

DEBUG：01111 

备注：1 为 ON，0 为 OFF。 

1.1 查看仿真器驱动是否正常安装 

开发板断电，把拨码开关调到 DEBUG 模式：01111，连接好仿真器和开发板，并将仿

真器的 USB 口插进电脑 USB 插槽，开发板上电。右击计算机图标，点击”设备->通用串行

总线控制器”或者”设备->端口（COM 和 LPT）”，查看是否有对应的仿真器的选项出现，

如有说明仿真器驱动已经正常安装，否则请先正确安装 CCS。安装方法请查阅使用手册

TMS320C6748 相关软件安装里 CCS 软件安装步骤。 
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图 2 

 

 

图 3 
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2 TMS320C6748 程序加载和烧写 

2.1 基于仿真器的程序加载和烧写 

2.1.1 设置工程配置文件信息 

 打开 CCS，点击菜单"View->Target Configrations"，右边弹出如下对话框： 

 

 

图 4 

 

 点击左边第一项，新建配置文件。 

 

 

图 5 

 

 输入工程配置文件名字，点击 Finish。 
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图 6 

 

 在弹出的对话框的"Connection"下拉框中选择对应的仿真器类型，在"Board or Device"

下拉框中选择 TMS320C6748，点击右边的 Save 按钮。 

 

 

图 7 

 

2.1.2 测试仿真器是否正常连接 
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点击"Test Connection"，看是否提示成功连接，如下图。如提示错误，请检查开发板

是否上电、接线是否正常。 

 

 

图 8 

 

2.1.3 加载 GEL 文件 

例程中使用"Tronlong_C6748.gel"文件初始化时钟配置如下： 

CPU：456MHz， 

DDR2-624，DDR_CLK：156MHz， 

EMIFA：114MHz。 

加载步骤： 

 点击 CCS 菜单"Run->Debug"，弹出以下界面。可以看到 C674X_0。 

 

 

图 9 
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 右击 C674X_0 核，在弹出的界面中选择"Open GEL Files View"选项，右下角会弹出"GEL 

Files（TMS320C674X）"对话框。 

 

 

图 10 

 

 在对话框内点击右键，在弹出的界面中选择"Load GEL"。选择 C6748 光盘 images 下

的 GEL 文件"Tronlong_C6748.gel"，再点击确定，接着右下角的"GEL Files

（TMS320C674X）"对话框会出现 Success 提示语句，如下图： 

 

 

图 11 

 

2.1.4 CCS 连接开发板 CPU 

右击 C674X_0 核，选择"Connect Target"选项，会显示 Suspended 状态。这说明 CCS 已

经和开发板 CPU 正常连接起来了。 
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图 12 

 

备注：此处提示"Nosource****"的信息，不是错误信息，可以将其忽视，仅提示当前

运行的 DSP 程序找不到对应的源文件，如果加载的是有效的 DSP 程序而且当前 DSP 程序

源文件位于磁盘中，CCS 会自动定位到相应文件并指向在相应的语句所在行。 

 "Tronlong_C6748.gel"文件加载后将自动初始化开发板，如下图所示： 

 

 

图 13 

 

2.1.5 查看 CPU 版本号 
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点击菜单"View->Memory Browser"，会出现"Memory Browser"窗口，在输入框中输入

"0x11700000"并回车，选择 Character 可查询 TMS320C6748 核的版本号，CPU 版本号在

out 镜像文件格式转换时将会用到。此处查询到的 DSP 核版本号为：d800k008，如下图： 

 

 

图 14 

 

2.1.6 加载文件烧写程序 

点击"Run->Load->Load Program"，选择光盘中 images 目录下的 C6748_NandWrite.out

或 C6748_NandWritev2.out 文件，点击 OK。接着点击绿色三角启动按键 。 

C6748_NandWritev2.out 使用了 Load Memory 方式，大大提高了烧写速度，其烧写速

度为使用 C6748_NandWrite.out 文件的 10 倍左右。 

2.1.7 基于仿真器烧写程序到 NAND FLASH 

(1) 使用 C6748_NandWrite.out 文件 

以 LED 流水灯程序为例，将光盘"demo\StarterWare\Binary\GPIO_LED.ais"拷贝到一个

非中文路径，在 Console 窗口"Do you want to global erase NAND FLASH?"提示行后面输入

y，按回车键进行擦除 NAND FLASH。擦除完后，会提示"Enter the binary AIS file name to 

flash（enter 'none' to skip）:"，在下一行空白处输入需要烧写的 DSP 程序镜像 GPIO_LED.ais

的完整路径，并按回车键。等待一会会出现"NAND boot preparation was successful!"即烧

写成功，如下图所示： 
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图 15 

 

 烧写完 GPIO_LED.ais 镜像后，拔下开发板仿真器接口，将开发板的拨码开关 1~5 号对

应拨到 01110 档位，这是 NAND FLASH 启动档位，接着上电就可以看到开发板 LED 流水

灯效果。 

(2) 使用 C6748_NandWritev2.out 文件 

以 LED 流水灯程序为例，将光盘"demo\StarterWare\Binary\GPIO_LED.ais"拷贝到一个

非中文路径，在 Console 窗口"Do you want to global erase NAND FLASH?"提示行后面输入

y，按回车键进行擦除 NAND FLASH。擦除完后，会提示"Enter the binary AIS file size:"，如

下图所示： 

 

 

图 16 

 


